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Before You Continue, Please Review These Quick Instructions:

At first glance, this document might seem a bit overwhelming in its breadth. Our students come
from many backgrounds and levels of technical experience. The following tips will help you get
exactly what you need from the manual, no matter what your level of computer experience
expertise.

IMPORTANT
' Along the way, we will highlight very important pieces of information with in boxes just like
@ this with the icon shown at left. No matter you're your level of technical ability, please make

sure that you read and understand these important messages.

KEEP IT SIMPLE : Read the Headings for Step-by-Step

This manual wasn’t designed to be read cover to cover! For most of us, reading only the headings
will be enough to know what we’re doing most of the time. Each heading is followed by detailed
instructions in case a user needs more help or wants to “drill down” and understand the feature or
function better.

New to technology? Focus on “Getting Started”

For many, a One Spirit course has been their first foray into using a computer at all. You're in good
company! We recommend that you look for the magic wand icon which indicates step-by-step
instructions in the “Getting Started” areas of each section of the handbook. As you get more comfortable
using the technology, read on and learn what more you can do to facilitate your learning experience.

Advanced Users : Make Sure to Catch Hints and Tips

While digital novices might have an abundance to learn at first, a few of you might live and breathe
technology to such an extent that most of this manual might be unnecessary. We have included some
advanced hints and tips for users like you, so as you scan through the manual, pay special attention to
features noted with the black gear icon at left. (Make sure you read all the Important Info sections too!)

~% 7 Getting Help - Use the Table of Contents, FAQ and the Back Cover
br - ‘ Find the section of the manual that pertains to the feature or function with which you need help, and read
P\ that section in detail. Also make sure to check the Frequently Asked Questions section and the back cover
\" of this manual. 90% of the questions students have can be found in this manual. Please make sure
you consult it before reaching out to staff.
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Technological Requirements

Regular Personal Access to a Computer with Internet Access

The computer should be “multimedia-ready,” meaning that it should be capable of displaying graphics, playing audio
and video. All computers sold today and over the last decade with the either Microsoft Windows XP, Vista, or Windows 7,
and any Macintosh with Mac OS X have this capability.

Familiarity with the Basics of Computer Use

It is important for students to be self-sufficient in accessing websites; downloading, saving and opening
files; and sending, receiving and managing email. The basics of Internet searching for research purposes
are also valuable skills. There are many free resources available through your local public library and online
at websites like the following:

http://netforbeginners.about.com/cs/internet101/a/inet_handbook.htm
http://www.bedford.lib.nh.us/Overview.htm

http://www.grassrootsdesign.com/intro/

http://www.aalrc.org/resources/tech/complit/welcome.html

http://en.wikibooks.org/wiki/Computers for Beginners

An Email Account

Please be sure to have a functioning email address. Much of One Spirit communication is through email. It is
imperative that we have an accurate email address for you at all times. Also, please be sure that One Spirit is not
blocked from your email box and that you do not “Unsubscribe” to One Spirit emails, as this can prevent faculty and staff
from contacting you.

Ability to Listen to Audiobook Files

Class recordings are distributed with audio files called Audiobooks via password-protected websites. All students,
attending and distance-learning must be able to listen to Audiobook files, also known as AAC files in order to
listen to any classes for which they are not present. After each class session, students download the Audiobook files to
their computers. The student can then listen to the audio at their convenience. In order to receive and play Audiobook
files, students must have the following capabilities:

o Broadband access to the Internet (Cable, Satellite or Digital Subscriber Line (DSL) or comparable) through an
account with an Internet Service Provider (ISP).
o Ample available hard disc space to receive audio files (500MB minimum, 2 GB recommended).

Making Audiobook Files Portable
Take your Audiobook with you, wherever you go by transferring it from your computer to a
portable audio device:

o Students can use portable digital music players, such as Apple’s iPod, iPad, iPhone, or any other device
that support the AAC file format. Sync your audiobooks to your device as you would any other audio file.
For help syncing audiobooks to Apple’s devices, please see the following website:
http://support.apple.com/kb/HT1386

o With a CD burner, students may burn Audiobook files to recordable CDs for playing in new portable CD
players that support the AAC format.




Event & Workshop Participation Agreement

We Keep You Informed : Important Announcements
WisdomWeb.org - Important announcements from educational and

administrative staff will be posted on class websites WisdomWeb.org '

under “Site News” and any “News & Announcements” from the faculty o

of your courses. Please check these areas regularly. y

Emails - Announcements may also be emailed - please make sure IMPORTANT
administrative staff always has your current email address. In accordance

with federal spam protection laws, mass emails from One Spiritinclude a Make sure you read the two pages of
link you can use to unsubscribe to all future mass emails. Please be this section in their entirety.

aware: unsubscribing from One Spirit emails may prevent faculty

and staff from contacting you.

Please Keep Us Informed of Registration Changes

Inform One Spirit by email to info@onespiritinterfaith.org of changes
in your contact information, requests to change your program status

They outline the policies, norms and
processes for One Spirit’'s courses
whether in the classroom, through
the website, online learning

(deferring, withdrawing), or requests to change your attending/distance community or download.
learning status.

Registration & Payment

O
O

o

O
O

Please register for courses online through our website - www.onespiritinterfaith.org

Students who have prepaid elective fees as part of a full-semester tuition payment agreement will be given special
instructions to register in their course materials.

Students from the General Public must submit payment online at the time of registration using a credit card or bank
account, orif unable to register online, by submitting a registration form with a check (made out to “One Spirit
Learning Alliance”) or cash.

Seating is limited; pre-registration is recommended.

Please arrive 20-30 minutes before start time to secure your seat.

Refunds & Cancellation

O
O
O

o

Refunds requested before an event will be issued minus a $10 processing fee.

No refunds will be issued after an event begins.

Participants who register as “attending” but who do not attend may download the audio recording (if available)
through WisdomWeb.org

One Spirit Learning Alliance reserves the right to cancel orreschedule any event..

Recording Equipment / Cameras

o One Spirit Learning Alliance reserves the right to record audio/visual archives of the presentation & class
participation of any event and to use these recordings for educational purposes.

o Use of recording equipment by students or other participants (audio or visual, including cameras) is not permitted
without the written permission of One Spirit Learning Alliance.

o One Spirit Learning Alliance endeavors always to honor requests for individual anonymity: participation in recording
(e.g. speaking into a microphone, appearing on camera, etc.) is optional, and it is up to each participant to exercise
her or his preference as to being recorded, taped or photographed.

Distance Learning

o Participants are eligible for distance learning if they either (1) live more than 50 miles from the event location, or (2),
know at the time of registration that they cannot attend a single-day event, or can attend less than half of the
sessions of a multi-session event.

o Many events (presentation & class participation) are recorded and available for Audiobook download. Please see
course descriptions to see which events are recorded.

o Audio recordings are delivered via One Spirit’s online learning community, WisdomWeb.org. All registrants will
receive instructions for accessing online resources after registration.

o Attending students are required to make up any missed class sessions by listening to the entire audio or video

recordings (if available) of that class. Audio recordings are available to all students via WisdomWeb.org at no charge.



Live Webinars

o Webinars are live audio-video Internet telecasts of classes where students may participate live using their keyboard
to ask questions of the faculty. Please see course descriptions to see which events are available via webinar.

o Inorderto participate in webinars, working knowledge of using a computer to browse the Internet, to send and
receive email and to download and play media files is required.

o Forquick, 3-minute overview of the webinar software, visit: http://seminars.adobe.acrobat.com/participatemeeting/

o Totest your computer and internet connection speed, visit:
http://connectpro67838903.na5.acrobat.com/common/help/en/support/meeting_test.htm

o Onrare occasions, students may be able to participate using their own voice through a microphone. A headset is
required for this functionality.

o Missed webinar sessions may be made up through Audiobook download.

Webinars have a deadline for registration of 12 noon the business day before a coruse.

o Inorder for webinars to take place, a minimum of 10 registrants must be enrolled for the webinar option. If
insufficient registration requires us to cancel a webinar, students will be notified via email.

o

Student Website (Online Learning Community) Participation Guidelines

One Spirit Learning Alliance provides a safe and fertile online resource where students can grow personally and in
community. In order to meet this objective, it is important that all participants are in alignment around some guidelines
for participation.

Confidentiality - You agree honor the confidentiality of what is shared in all venues of One Spirit educational activities,
both in the classroom and online.

Content Sharing —You agree to not share content and course materials from this website with non-members. Naturally,
we are on this website to share with each other, but in order to ensure a safe learning environment and a secure online
community, all content posted on this website is off-limits to everyone but students and staff per the terms of your
student participation agreement.

Responsible Communication — Recognizing the power of speech to create both good and harm, you agree to practice
honest, loving, and responsible communication, and to refrain from gossip and other forms of harmful speech. Speak
that which is true, useful, and kind, and refrain from spreading gossip, rumors, or that which you do not directly know to
be true.

Contact Information — You agree to provide a valid e-mail address, phone number and mailing address in your
member profile so that classmates, faculty and staff can contact you directly if necessary.

Privacy — Honor the privacy of your fellow site members. You agree not to repurpose information about classmates from
the classroom or the website for your personal or professional use without their express permission. Contact information
for your classmates, like all class website content, is private and may not be disseminated to non-members.

Solicitation — This forum is for exchange of ideas and community

building. While all members are enthusiastically encouraged to share /)
events and resources with your classmates, please do so in the spirit of —
education and community. You agree to refrain from solicitation and/or Y

Do not email

=3 anything which N
Y you would not 8
be prepared toY '
say directly to
someone's face! j/

— >

promotion for personal gain for yourself or others.

Complaints — Occasionally, we encounter each other in conflict. If you
feel that these guidelines have been broken, please let us know so
that we can help transform any problems into opportunities for
growth. Please report community-related complaints and problems to
your dean or academic advisor. Do not post problem reports and
complaints publicly on the site.




Registering for Public Workshops and Electives

One Spirit Learning Alliance offers a wide selection of curriculum, from short-term workshops that

meet over the course of a weekend, to ongoing certificate programs that convene monthly over

the course of a year or more. Enrollment in certificate programs such as the Interfaith Seminary, or

other full-year Training Programs is granted through an admissions process. By contrast, the
short-term workshops and electives are available through a simple, web-based registration system.

Step 1: Select your course at www.onespiritinterfaith.org

o Available courses are listed on the website calendar as well as on the Public Workshops page. Maker sure to take
note of the availability of distance learning and the number of One Spirit elective credits allotted.

o Choose your course and click the Registration link to be taken to the registration system.

o From WisdomWeb.org, you can click “Register for Electives” in the Navigation Menu on every page of the site.

Step 2 : Register and Pay
o Ifyouare a student enrolled in a full term program who has pre-paid an elective fee:
*  Click the link shown at right to enter your discount code.
* Enter your electives code in the space provided and click the “Apply Discount” button. The course prices will
change to reflect an updated student price.
o Review the different “Ticket Types” based on attending or distance learning options, and select the number of
people you wish to enroll for each ticket type.
o Click the “Order Now” button to continue.
o Reserve your tickets by completing the data entry and agreeing to the participation terms for each person enrolled.
o Complete your purchase, if necessary, by entering your payment details.

Step 3 : Make a Note of Your Enrollment Key

The registration system will confirm your registration and issue you '
an enrollment key. Make a note of the key. And justin case you lose it, a
key will be automatically emailed to you as well.- ‘ o

Step 4 : Unlock Your New Course on www.WisdomWeb.org

o Go to WisdomWeb.org, click the Login link and enter your login
credentials.

o NOTE: If you are not currently enrolled in a full-term program and have
NOT received WisdomWeb.org account information from the
admissions department, please “Create a New Account” by following
the instructions on the right side of the login page. Once you have
completed the steps to create an account and you are logged in, you
may proceed with the following steps.

o From the Navigation Menu tool block, under the
“Electives” heading, select “Unlock a Course with
Enrollment Key.”

o Scroll down through the list of available courses and
click the title of the course for
which you have registered.

o On the page that opens, type
your enrollment key exactly as
it was given to you and click
“Enroll Me”

o The course’s home page will
appear. Take a moment to
read any important
announcements from faculty
and staff so you will be certain
to be up to date.



WisdomWeb.org — One Spirit’s Online Learning Community

One Spirit provides some classes their own websites to facilitate the
. distribution of distance learning materials, provide important information
related to coursework, and foster sharing of information that deepens
/ ' \ understanding of course content.
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IMPORTANT Who Has Access to WisdomWeb.org?

To protect the privacy of our students, WisdomWeb.org is password
protected. All students enrolled in One Spirit classes or workshops are given
instructions to access the website and are encouraged (and occasionally
required) to participate.

WisdomWeb.org is the primary way we
communicate important announce-
ments about classes and workshops.

Who Is Able to See My Participation?

Once you are logged in, there is yet another layer of security based on your

or a Distance Learner, please login to course enrollment. You may only participate in courses to which you are

WisdomWeb.org as soon as possible. enrolled, and only members of your class, One Spirit Faculty and staff have
access to your course materials and are able to see your participation.

How to Get Started with WisdomWeb.org

1. Visit http://wisdomweb.org and click the link to “Login” - The login link takes you to the WisdomWeb.org website
where you have a choice to login or to create a new account as seen in the image at right.

Whether you are an Attending Student

2.If you've logged into WisdomWeb before or if One Spirit staff emailed you an “Invitation” including a
username and password, login using those credentials. (do not create a new account).

TIP: Use one login account for all your courses!

3. If you do NOT have a WisdomWeb.org account, follow the instructions at the right under “Create New Account” to
get started, then come back to these steps.

4. Change your password (if desired) — from the “SETTINGS” section in the rightmost column, select “My profile
settings” and then “Change password” Be sure to pick something that you will remember.

5. Edit Your Profile — Once you are logged in, from the Navigation Menu at the right, select the “Edit” link from the “My
Profile” section.

6. Explore and SAY HELLO! - Practice navigating and become familiar with the tools and sections of WisdomWeb.org.
Go to your “My Home” page (the fist link in the navigation menu) and enter one of your classes. If a discussion forum is
available, make sure to say hello and introduce yourself. Try the features and download files. Encourage others to
participate by participating yourself!

| don‘t Know.

The computers
are down.

What is
the meaning
of life?




Updating Your Profile

To update your profile, select the “Edit” link in the “Profile”
section of your navigation menu, or select “My Profile” from the
“SETTINGS” section in the Tool Block Column or the Dock. We
recommend using the following settings::

Name: You must use your real name.
To ensure the privacy and safety of our online community, it is
important that your classmates, faculty and staff can identify
you. Accounts misrepresenting their identity may be banned
from courses or WisdomWeb as a whole.

Email display
Choose who can see your email address: all site members, only
members of your courses, or nobody but faculty and staff.

Email digest type

WisdomWeb.org will email you updates of discussions in any

forums to which you are subscribed:

o “No Digest” sends you one email per new post

o “Complete” sends you one email per day that includes the
full text of all posts

o “Subjects” sends you one email per day of just the subjects
that were posted that you can click to read on the website.
We HIGHLY recommend this “Subjects” option.

Forum auto-subscribe

This option determines whether or not you want to automatically
receive email notifications about new posts to forums to which
you are a member. PLEASE NOTE : faculty may override this by
making some of your forums mandatory.

Time Zone

This helps WisdomWeb coordinate schedules and deadlines for
you, wherever you are in the world. To learn your UTC formatted
time zone, visit
http://www.timeanddate.com/library/abbreviations/timezones/
and click your continent for a short list.

Description
Input a brief bio so that classmates have more touch points to
remember you. Feel free to write whatever isimportant to you.

Picture

All One Spirit students are asked to upload a real, preferably
recent photograph of yourself, so people get to recognize you.
This picture will display next to your posts on the website.
Detailed instructions are listed at left.

List of Interests
Enter your interests, spiritual path, and passions separated by
commas.

Click “Update Profile” at the bottom of the page
to save your changes!

UPLOADING YOUR
PICTURE

On your edit profile page, find the “User
Picture” section & click “Upload Photo.”

The File Picker will appear. Click “Upload”

Click the “Choose File” button

A window will open where you can find the
picture you wish to upload on your
computer. Locate the file and click “Choose.”

Your file will be listed now in the
Attachement box. Click “Upload this File”

After the file uploads, it will be listed in the
new picture field. Make sure you click
“Update Profile” at the bottom of the
page to save your change!



How to Login to WisdomWeb.org

After you have a WisdomWeb.org account you can use it to access every class you take at One Spirit Learning
Alliance. You just need to login.

Enter at http://wisdomweb.orq/ and click the

“Login” link at the top right of the page.
As mentioned previously, you will be immediately directed to
your WisdomWeb.org “My Home” page listing all of your

courses, unread messages and recent news. 2N
Login Not Working / Forgot Your Password? b ‘
Not to worry: we all forget passwords, especially the guy who \‘ -

set up the website! WisdomWeb.org has a username and
password recovery tool that sends emails with instructions to
the email address you have on file with the site. To activate
the recovery tool, simply click the link on the login page
indicated atright:

NOTE: You Only Need One Account: One WisdomWeb.org account will grant you access
to any Class to which you are registered. The instructions on this page assume you have
already created an account with WisdomWeb.org. If you have not yet created your login
account, please see page 9 to get started.

YouVE HAD THE POWER T6 GO BACK The More You Participate, The More You
ALL ALONG...JUST CLICK. THE RUBY Learn
SLIPPERS ICON THREE TIMES AND WisdomWeb.org was built using a Learning

SAY “THERE'S NO PAGE Management System (also known as a Virtual Learning
Environment) called Moodle at our online learning community,

WisdomWeb.org

Moodle was developed to support teaching and learning within
Internet-based communities of reflective inquiry. The philosophy
behind Moodle is based upon an approach to education that learners
(and not just teachers) can contribute to the educational
experience, thereby enhancing not only the learning others, but
their own.

How Does One Spirit Learning Alliance Use Moodle?
Some teachers love to while others prefer to use Moodle as a way to
deliver content to students (such as audiobooks and related reading

;g\} materials) and assess learning by measuring participation and by using
s S assignments or quizzes. Different classes have different needs. Some
classes use the website exclusively for the distribution of recordings
and handouts to distance learning students. Others may use the
activity modules (such as forums, databases and wikis) to build richly
collaborative communities of learning around their subject matter (in
the social constructionist tradition), as a system to aid in the
development of community and facilitate communication among
students. Thus, for some classes, your participation in the website is as
critical to your learning as your absorption of course lectures. In any
event, your faculty will decide how to best use WisdomWeb.org to
facilitate your learning and communicate clear expectations for
your participation.

10



The WisdomWeb.org User Interface

Page Areas
Most of the pages on WisdomWeb.org are
divided into two page areas:

Main Content
(shown at right in pink) — is where your
course materials, messages, etc. will appear.

Tool Blocks Column

(shown at rightin blue) - is where you can
find useful tools organized into blocks that
rest on top of each other. The available tools
change from page to page, depending on
what you're viewing in the Main Content
Area. For example, while viewing course
content, blocks might show which classmates are currently logged in, a list of recent updates, and the settings menu. By
contrast, if you're viewing your messages, the blocks might show only recent news and the settings menu. Some
examples of Tool Blocks are as follows:

SETTINGS - a powerful menu that dynamically changes from page to page allowing you to customize
your experience. You will always be able to find your User Profile and Password Change options
in the SETTINGS Menu in the Tool Block Column.

Tool Tips - Instant Help for Tool Icons

Throughout the site, you will see features you can

activate by clicking graphic icons. You will

eventually get to know these tools very well. In the
meantime, the software has a clever feature that will tell you
exactly what an icon does. Simply place your mouse pointer
over the icon in question without clicking. A small text box will
pop-up in a few seconds with an explanation of the tool’s
function.

Organizing Your Blocks — Using the Dock

You will notice that each block has two icons to the right of

the block’s title. The “Hide Block” icon, with the image of a

minus symbol, will collapse the block to just the block's title.
This is useful on pages where many blocks appear, and you wish to
temporarily hide blocks that you don’t need. The icon then becomes a
plus symbol. Clicking again will reveal the block.

The other powerful feature is the ability to move blocks to a “Dock” on the
left side of the screen. The icon that looks like two columns will instantly
place a dock on the left side of your screen and convert the block into a
drop-down menu. Use this when you use a block very often and want to
always have it at your fingertips. Once on the dock, the menu will show
another dock icon you can click to restore the block to its original place in
the Tool Block Column.

11



Getting Around - Finding What You Need

My Home

Upon logging into WisdomWeb.org, the first page you'll always see is “My Home .” This page is a simple way to see what
is most important for you to know across the site and in each of your courses, all in one place. The page first shows links to
all your courses, including their recent activity, important site news items, and unread messages sent to you by other site
members.

The Navigation Menu

This menu, at the top of the Tool Block Column on every page, lists WisdomWeb.org’s most commonly used
features, including your My Home page, the Messaging Center, Site News, Profile options, Tech Support,
Electives Registration and Course Unlocking. More about each feature will follow in this manual.

The Navigation Path

At the top of the main content area of every page on the site is a navigation path. This is a list of links
that show you your current location in the site with links to higher content views. Let’s use a real-world
metaphor of a map: if you were looking at a map of the One Spirit office, and a navigation path were
available to you, here is what you might see:

Earth > United States > New York State > New York City > West 36™ Street > One Spirit Office

Your current location is the farthest right itemin the list. Each successive item to the left reveals a higher content view, the
street that houses the offices, the city that houses the street, the state, its nation, etc. In our metaphor, by clicking any
link in the navigation path, the map would zoom out to a bird’s eye view of the item you clicked.

The navigation path on WisdomWeb.org works
the same way: your current location is at the far
right, and each link to the left will take you out
to a higher view of the website. Another useful
metaphor is to think of each section having
parents and children. Older generations are to
the path’s left; children and grandchildren are
to the right of the path.

12



Looking at a Sample Course

Every course is unique and will offer students different online learning options. The organizing principles are generally
the same. The top of the main content area is devoted to materials and activities you will be using for the length of the
course, Faculty Announcements, Discussion Forums, Reference Materials, etc.

You will notice extra tools when you’re on a Course Page

As shown in the illustration at right, you will see tools on course pages that are not available
on other sections of the website. Search Forums allows you to search all the discussions for a
keyword. PEOPLE lists the faculty and students enrolled in the course. RECENT ACTIVITY lists
the most recent updates in the course, very helpful for knowing what'’s new.

Content that pertaining to each individual class session will be listed

separately in content sections down the page.

As shown below, each section consists of the content that pertains to that particular class
session and may include Audiobooks, videos, handouts, web pages, and any other
collaborative activity the faculty chooses for your course. If your class is live (not pre-recorded),
the current class session may be highlighted in yellow to make it faster to spot. Some courses
may have assignments that are listed with each module. Your instructor will let you know
whether there are assignments for your course, and if they are due through the website.

13



Getting the Most from Your Discussion Forums

What are Discussion Forums?
Some courses will offer Discussion Forums where you can exchange ideas with the faculty and your classmates.
In contrast to private messages, which are private conversations between 2 people, Discussion Forums are the
equivalent to open discussion in a classroom setting.

In the past, students used email to stay in touch between classes, but so many classmates emailing every day to stay in
touch resulted in a lot of duplicated messages, disjointed conversations and cluttered email inboxes. Using discussion
forums, a student can post a message once in one place for everyone to read. Classmates respond to the post right on
WisdomWeb.org, so responses back and forth become an online conversation. And unlike email, the conversation will be
on archive for posterity. Think of WisdomWeb.org as a virtual classroom and connection hub.

What Makes a Discussion Forum Successful?

In short, the more people collaborate and stay in touch with each other, the more interesting the site becomes and in
turn, the more frequently class members visit and contribute. If everyone makes an effort to post at least one thing per
week, discussion forums become a vital, fun resource to all.

. . )
What Should I Post to Discussion Forums? What if  Don’t Have Anything to Say?

Different courses will have different types of Topic
Headings, as determined by faculty. Anything you
want to share with classmates should go into the
appropriate topic heading. If you have suggestions for
additional topics for a course’s forums, please contact
the faculty for the course with your request. The
following represent some common topics on
WisdomWeb courses:

Preposterous! If you have a pulse, you have something to
say! And it is important service to add your voice to
the discussion. On the Internet, people who don't
participate, who only read the work of others without
submitting their own, are known as “lurkers.” Most
people “lurk” innocently, because they feel that they
have nothing to add, and that nobody would notice.

Classroom Discussion - This is the place to talk
about any responses you had to the most recent class
session, any reflections or questions you'd like to
share with each other.

Inspiration and Resources - A forum can be a place
for students to share with each other anything that
might inspire others: songs, poems, pictures,
scriptures, passages, worship services, spiritual
organizations, books, web links, and on and on.

Casual Conversation - Keep everyone up-to-date on
your personal life and interests! Your class website is a
place for social interaction and fun.

The truth is that your presence on a One Spirit class site
is known by your classmates, whether you participate or
not, and those who do post can lose trust in the
community if there isn’t equal participation. Don’t lurk
in the shadows. Take a brief minute to share your

thoughts and questions with your classmates, and
most of all, HAVE FUN!

Keeping Discussions Topical

The forums are organized around discussion topics.
These topics encourage focused discussion and make it
much easier to find relevant conversations in the future.
Topics will be different in each class, so familiarize
yourself with the topics and please make sure that you
are in the right place before starting a conversation. For
example, an event invitation would be misplaced in a forum discussing classroom topics. Likewise, a request for
homework support might go unnoticed if posted to a forum listing links to websites, books and movies. Also, keep in
mind that some topics, for example, “Announcements from Faculty” will be read-only to you and other students, so you
will not be able to post new
content or reply to posts in
those forums.
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column indicates the number of
messages that have been posted
which you have not yet read. To add a
new discussion, click the button at
the top center of the discussion list
as shown in theillustration above.

on one page. Think of the posts and
replies as parents, and children. Some
replies will engender replies of their
own, just as some the children will
have children of their own. So as the
conversation grows, many generations
of replies develop.

Without some help, it can get
confusing to know how the
conversation should flow. Luckily,
there are a couple of tools to help you
understand the sequence of
conversation. First there is the Views
dropdown list at the top of any
discussion page. There are four
options for viewing any discussion.
“Display replies in nested form”
(shown at right) is the most commonly
used format. We encourage you to try
out each format and use the one you

Drilling Into a Topic - Listing the Conversations
In the following example, we are going to drill into the “Classroom Discussion” topicto reveal a list of
conversations. You'll notice that the Discussions with the most recent posts sort to the top of the list. The “Unread”

Reading the Discussion

When a discussion is very
popular, there will be many replies

like best.

Another helpful tool is the “Show Parent” link, available directly below every post in the conversation. Clicking this link
will jump to the exact post that your classmate is replying to.

Replying to the Conversation

Notice that the Parent Post and each reply has its own “Reply” link, to the lower right of each comment. Click the “Reply”
link directly beneath the message you wish to reply to: this will ensure that your reply is not misdirected, but rather will
be read in the appropriate context.

Miss Manners says, “Please Use Proper Netiquette.”

Netiquette is a portmanteau of Internet and etiquette: what to do and not do when communicating online. Here is a
short list to help you communicate effectively on the Internet.

O
O
O

DON'T USE ALL CAPS! — In Internet or email language it is the same as shouting.

Before creating a new topic thread, please search to see if a similar topic already exists.

Remember we are all human — It is easy to forget that there is a person behind that computer, but try! We can't
see facial expressions or body language, so words can easily be misinterpreted. Be the same person online you are
offline — which has two meanings: first behave with the same standards of behavior online that you do in person,
and also feel free to let your personality show in your communication.

Let the subject line work for you — Many people decide whether or not to read a discussion post or email by what
isin the subject line, Make sure it reflects the content of the message.

Be forgiving — When someone makes a mistake - whether it's a spelling error, a silly question or an unnecessarily
long answer - be kind about it. If you decide to inform someone of a mistake, point it out politely, preferably by
private message rather than in public.

Don’t Lurk: Participate! — See “What if | Don’t Have Anything to Say” on the prior page.
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Getting Set Up For Audio

One Spirit Learning Alliance records most of its programs, courses and workshops so that distance learners (and absent
attending students) can listen to the lecture and discussion from class. The audio is distributed through your class
website using Audiobook files in the AAC format.

First: Install the Latest Version of the iTunes Software

There are many, many software packages that play Audiobook files. You are welcome to use any software you prefer, but
please be advised that One Spirit staff will not be trained to support any software but iTunes. We also recommend using

the latest version of the software., though itis updated almost monthly. Any recent versions of the software will work, but
please keep in mind that the interface depicted in this document’s images might be from a different version of the
software and may vary slightly to the version on your computer.

o Ifyoualready have iTunes installed on your computer, please update it to the most recent version:
o PCUsers - From the iTunes “Help” menu, select “Check for Updates...”
o MAC users - From the “iTunes” menu, select “Check for Updates...”

o Ifyoudon’t have iTunes, you can download and install it easily
o Go to http://www.itunes.com/
o Click the blue “Download” button and follow

the simple instructions. Windows Users
select “Preferences”
Next: Configure iTunes from the “Edit” menu
) In order to ensure a seamless file transfer and
/ ' \ playback, we're going to setiTunes to be the

default program to open Audiobook files.

~ This will save you lots of time later.

Please configure iTunes as follows:

o Open iTunes on your computer

o If a Sidebar is open at the right side of window, click
Hide Sidebar to close it.

o Open Preferences

o Click the “Advanced” Tab and make sure the
following three boxes are checked:
* KeepiTunes Folder Organized

e Copy MusictoiTunes Folder when adding to library. Mac Users
e Windows Users only: Use iTunes as the Default select
Media Player for Audio Files “Preferences” from

Click OK to save your preferences.

Learn More About iTunes
Take some time to get familiar with iTunes.
iTunes comes pre-installed with excellent video tutorials
that will teach you the vast array of things you can do with this
software. Please take some time to view these tutorials and get
to know iTunes better!

Click the “Help” menu and choose “Welcome to iTunes.”

Or “iTUNES TUTORIALS”
The tutorials will open in a separate window.
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Getting Audiobook of Your Class From the Web to Your Computer

Why Audiobooks?

Audio of your class recordings from a full day of class is compressed into one
audiobook file. You will use the following procedures after each class to
download the audiobook containing lectures, exercises and discussion. The
Audiobook "m4b" file format is based on the next generation of MP3 files,
and offers our students many advantages over prior methods of delivering
you audio:

o

Simplicity. Only download one file per class session. No more waiting
for the mailman or downloading multiple tracks per day and keeping
them allin order!

Chapters. Audiobook files contain descriptive chapter listings,
accessible through the software, like bookmarks that allow you to skip
backward and forward through the class material.

Portability. The audiobook format is compatible with the Apple’s iPod,
iPhone, iPad and myriad other devices, so you can take your class work
with you wherever you go.

Memory. Whenever you stop playback of the audiobook file, your
software will place a bookmark in the exact spot you stopped and
resume playback there, even if you have to turn of your computer or
play other audio in the meantime!

How to Find and Download Your Files

1.

Login to WisdomWeb.org and click your course title from the My Home
page as show at right:

On the Class Page, find the module that lists the Audiobook you wish
to download. The current, or most recent module is usually highlighted
in light yellow.

In the module’s section, examine the list of available files and activities.
Find the Audiobook you wish to download, and dlick its title and follow
the instructions to initiate the download.

Wait for the audio files to download. Audiobook files in particular are quite large and will take some time to

download; just let the download run until itis complete.

After the download has finished, double click the audiobook file to open itin iTunes. If this does not work, Drag the
file icon into the Library Section (near the upper left) of your iTunes window.

~'u-.-.'-lu|u|u-p.-:|-.n T y

=
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Listening to the Class

1. Open iTunes & click “Audiobooks” (in the “Library” list at the left

of the window) m
2. Select “Show Browser” from the “View” menu If you see a white

or black window with pictures like the one

shown above, select “Show Browser” from the “View” menu

(as seen at right). The Browser shows you all your audio files

in a list view and allows you to filter the list and sort through
them very easily.

3. From the “View” menu mouse over the “Column
Browser” submenu. In that submenu, click each of the three

following items so that they become checked: “Artists” “Albums”
and “On Left.” 2

Optional: If you have a lot of audiobooks from other
providers, you might want to click the “Genres” option
(shown in pink), as all One Spirit audiobooks are tagged
with a Genre “One Spirit.”

Remove checks on any other options by clicking them. When you are
finished, the Column Browser menu should look like the menu depicted
below (Genre is optional):

4, Notice the columns that appear to the left E

of the iTunes list view: Artists and Albums. The
audio files associated with the Authors and Albums
selected appear in the list view, highlighted in
yellow at the right. Since “All” are selected in the
Authors column, and “All” are selected in the
Albums column, all 5 audio files are shown in the list
view.

5.Choose an

“Author” and an
“Album”
This will narrow

down the number of
files in the list view,
making your class
audio easier to find.
All of the audio files
you download from
One Spirit will have
“One Spirit” as the
name of the Genre, as highlighted in

pink in the example above. In the

example below, notice that by

choosing “Ancient Wisdom in Modern
Life” in the “Authors” column, this
narrows the options for the Aloums
(in yellow) down to two, and the
tracks are down to 2 as well.
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4,

FOR EXAMPLE : To play the audio of October class work for “Ancient Wisdom in Modern Life,” one

would

1. Click “Ancient Wisdom in Modern Life” in the Authors column
2. Choose the Date of the class desired in the Albums column
3. Click the first track listed alphabetically (notice they are sorted by Year, then month and date)

Click the Play Button to begin playback.

Diamond indicates
the current chabter.

Audiobooks Have Memory!

When you Pause or Stop playback,
your software will insert a virtual
bookmark and remember to start
there next time, even if you have to
turn off your computer.

Playing the Audiobook Format

The figure at the leftillustrates the many
benefits of using the audiobook format for
distributing lengthy audio content. The format
is very similar to MP3s, M4As, and other
standard audio files with a couple of important
distinctions:

There are Chapters

The media team embeds chapter markers at
logical spots during the class session. Clicking
on the Chapters menu will skip to that pointin
the audio, just as if you were skipping to a
chapterin a book.

Playback Memory - Bookmarks

When you pause playback or stop it
completely, your software will insert a virtual
bookmark and remember where to begin
playback the next time you listen.

Keep this in mind, if audio playback begins at
an unexpected place:itis possible that a
bookmark is pointing to a prior place you were
listening. Simply use the Chapters menu to
skip to the place you want to be.



Webinars : Live Webcasts to Anywhere in the World

One Spirit Learning Alliance is excited to offer some courses via webinar. These webcasts are live
audio-video Internet telecasts of classes where students may ask participate in the moment using
their keyboard, and sometimes their voice to ask questions of the faculty.

What is the webinar experience like?

See for yourself: watch a quick, 3-minute overview at the following link to see how webinars
work: http://seminars.adobe.acrobat.com/participatemeeting/

At One Spirit, a typical webinar starts 15 minutes before class begins. A staff moderator, whose primary role is
integrating the webinars students with the live classroom, will be present to allow students the opportunity to test their
systems. Once class begins, the webinars students see and hear live video of the instructor from the classroom. Webinar
participants use a text chat box to ask questions of the teacher or get help from the moderator. In the case of comments
and questions to be communicated to the entire classroom, the webinar moderator will raise her or his hand on your
behalf when appropriate and read your message aloud to the classroom.

Some select webinars will allow students to ask questions in their own voice. Participants click a button to virtually “raise a
hand.” As with text chat questions, the moderator will physically raise a hand in the classroom on your behalf when
appropriate. When called on by faculty, the moderator willannounce the student to the classroom and connect the
student’s audio. The student un-mutes her or his microphone and speaks directly through the classroom speakers.

Webinar Technical Requirements

Standard Requirements

In order to participate in a webinars, a student must have working knowledge of using a computer to browse the
Internet, to send and receive email and to download and play media files. This is no different from the requirements to
download audiobooks and use WisdomWeb.org

Additional Requirements

A broadband Internet connection is required; a wired connection is preferred to WiFi

Nearly any computer operating system including, Windows, Macintosh, Linux and Solaris

Web Browser: Internet Explorer, Firefox, Safari, or Chrome

Adobe Flash Player version 10.1 (a free download from http://get.adobe.com/flashplayer/)

Speakers (headphones are preferred) are required to listen to the webinars audio

Some course may offer students an opportunity to participate using their own voice through a microphone: a
headset (not room speakers) is required for this functionality.

To test your computer and internet connection speed, visit:
http://connectpro67838903.na5.acrobat.com/common/help/en/support/meeting _test.htm

O O OO0 OO0

o

Registering for a Webinar

PreRegistraiton is Required by 12 Noon EST the Business Day BEFORE the Webinar
To participate in a webinar, just register as you would for any course, selecting the webinar option ticket type. Please see
course descriptions to see which events are available for webinars participation.

Webinar Registration Minimum

In order for webinars to take place, a minimum of 10 registrants must be enrolled for the webinar option. If insufficient
registration requires us to cancel a webinar, students will be notified via email and/or the class’ page on WisdomWeb.org.
Students will be given the option to download the course audiobooks or to take a different webinar.

Logging Into a Webinar

Instructions for joining each webinar may vary depending on the webinar type and number of attendants. The class
page on WisdomWeb.org will contain specific instructions for joining the webinar for each available course, including
detailed instructions on how to use the webinar software. It is very important to read this material before the
webinars begins, and to log-in 15 minutes early to make sure that your equipment is set up correctly.
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Frequently Asked Questions

What if | forget my password?

You have the power to change it yourself using the WisdomWeb.org password change tool. On the website’s
login page, click “Forgot Username or Password?” — a special link that you can use to have your login details emailed to
you.

How do I change my username, password

or other personal information?

1. Log into WisdomWeb.org as described above.

2. Open the Settings tool in the Tool Blocks column at the right of the page. If
you can't find the Settings Tool, check to see if it's hidden or if you moved
it to the dock that runs down the left side of the page.

3. Click “My Profile Settings” to open the menu of profile, password and
notification options. And follow instructions on each page to change your
information.

I’'m getting too many emails! How do I reduce the frequency of

notifications?

1. Login and follow the instructions directly above to edit your profile. From
the “Email digest type” setting, select the “Subjects” option. This will send
you a maximum of one email per day of forum notifications.

2. From the “My Profile Settings” menu in the Settings tool, (see above) select
the “Messaging” option to turn off all notifications.

Where Can | Learn More? /How Can | Get Help?

WisdomWeb.org : Click the “Tech Support” link in the navigation menu on any page on your class website. You can
read frequently asked questions, search our support forum or ask a question yourself in our support forum.

iTunes : Visit the iTunes website at
http://www.itunes.com

Helpful resources are also listed on the back page of this guide.

I need help with my computer. Do you do tech support?

While we are able to assist you with the use of WisdomWeb.org and iTunes software, problems that are related to the
physical equipment you own (such as your computer, monitor, iPod, iPhone or printer), the Internet service you purchase
(your cable or DSL provider) and/or the operating system you use (such as Windows, Mac OS X, etc.) are outside the
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limits of our technical knowledge and abilities.
Search your local Yellow Pages for resources near
you that can offer expert advice for these
specialized areas.



If you get stuck, please make sure you have read the applicable sections of this guide thoroughly.
Use the Table of Contents to find what you need. If that doesn’t help, refer to the resources below:

If you need help with...

Try These Actions First

If That Doesn’t Work...

Administration:
Changes in Your Contact
Information

Education & Classwork:
Questions about Content,
Assignments, Reading,
Requirements, etc.

Class Website:
Username & Password
Access Denied

Class Website:
Difficulty Using
WisdomWeb.org Software

Class Website:
Get access to a new
course’s class website.

Class Website:
Too Many Emails

Class Website:
Change your profile

Course Registration:
Wish to Register for a Class

Registration Changes:
Canceling registration,
switch distance / attending

iTunes:

Trouble using iTunes,
Difficulty listing or playing
audio...

Technology:

Using a computer for
anything not addressed in
this guide.

1.

—

—_

Email info@onespiritinterfaith.org

Post a Question to your Class Website
Email another Student in Your Class

Make sure you're on the the right website:
http://wisdomweb.org/

Make sure “Caps Lock” is off on the keyboard
Try your username and password again

Click the “Tech Support” link from the navigation
menu on any page on your WisdomWeb.org.
Search the support forums for an answer

Post a new question

Register for the class through
http://onespiritinterfaith.org

Registered students will receive an email
confirmation from the registration system with
instructions to Unlock your new course.

See page 22 for instructions on configuring your
profile to reduce the number of email messages.

Call One Spirit
Administration:
212-931-6840 ext. 0

Email your academic
advisor, dean or teacher.

On the Sign In Page, click
“Forgot User Name and
Password?” and follow the
instructions there.

Email One Spirit
Technical Support:
tech@onespiritinterfaith.org

Email One Spirit
Administration:
info@onespiritinterfaith.org

Click “Tech Support” in the
navigation menu.

On the website’s login page, click “Forgot Username or Password?” — a special
link that you can use to have your login details emailed to you.

Go to http://www.onespiritinterfaith.org/events/
Use PayPal’s secure servers to pay for the course
with a credit card or your bank account.

Email info@onespiritinterfaith.org

Make sure you are using the most recent version
of iTunes (see page 11) & have read this guide.
Watch “Welcome to iTunes” videos (page 12)

Click “iTunes Help” from the “Help” menu and type
in some words related to your problem.

Go to http://www.google.com/

Type in a few words pertaining to what you want
to do, or type in a question.

Click “Google Search”

Browse results and read a few to see if they help.

Call One Spirit
Administration:
212-931-6840 ext. 0

Call One Spirit
Administration:
212-931-6840 ext. 0

Email One Spirit
Technical Support:
tech@onespiritinterfaith.org

Email One Spirit
Technical Support:
tech@onespiritinterfaith.org

212-931-6840 ext. 0

Anything Else:

Email info@onespiritinterfaith.org
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